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ArcGIS Online Tutorial 

Patrimonio culturale: mappatura dei siti a rischio a Roma 

Il paesaggio italiano è caratterizzato da una serie di elementi d’interesse storico e archeologico che definiscono 

gli assetti territoriali, in materia di pianificazione urbana e gestione dei rischi. Tali elementi distintivi 

costituiscono il patrimonio culturale nazionale. Per questa ragione sono tutelati a norma di legge ed orientano 

la pianificazione strategica del territorio, attraverso attività di fruizione e valorizzazione a fini turistici e 

ricreativi. Questo tutorial ha lo scopo di fornire all’utente strumenti di analisi GIS basilari per la ricognizione 

e la gestione del patrimonio culturale (archeologico e di interesse storico-artistico) in relazione a fattori di 

rischio. In particolare l’utente impara a gestire ed analizzare dati di diversa fonte e natura per realizzare mappe 

a sostegno delle attività di tutela e valorizzazione del patrimonio culturale. Il caso applicativo di studio 

riguarda la città di Roma (Italia), il cui patrimonio storico e archeologico è diffuso su tutto il territorio urbano, 

comprese le aree periferiche e marginali. 

Obiettivo #1: Applicare tecniche di gestione dati e di analisi spaziale per presentare una mappatura immediata 

e di semplice lettura del patrimonio culturale tramite strumenti di ArcGIS Pro. 

Nota: I dati impiegati in questo tutorial sono forniti da enti pubblici territoriali (ISTAT, Regione Lazio). Le 

informazioni contenute fanno riferimento alle rilevazioni statistiche e territoriali effettuate dagli enti sopra 

menzionati. È possibile dunque che al momento della scrittura di questo tutorial, i dati impiegati non siano 

stati adeguatamente aggiornati. I dati impiegati tuttavia consentono di introdurre l’utente alle basilari funzioni 

di analisi spaziale fornite dalle piattaforme ESRI e di migliorare le capacità tecniche tramite strumenti e dati 

GIS. 

 

 
1. Trova e scarica i dati dai seguenti portali istituzionali di open data geografici: 

• ISTAT Basi Territoriali > Aree subcomunali > WGS 84 UTM Zona 32N 

• Open Data Lazio > Dati > Dati Geografici 

1. Quadro unione mappe del rischio Polygon 

2. PTPR-Tav. B-Beni singoli Polygon 

3. PTPR-Tav. B-Punti archeologici Points 

4. PTPR-Tav. B-Punti rurali identitari Points 

 
Poi salva i dati su un percorso di cartelle a tua scelta nel proprio dispositivo 

 

 

2. Apri un nuovo progetto sul software ArcGIS Pro 

• Clicca su Create a new poject > Blank 

• Nomina il progetto come “Cultural Heritage_mapping sites at risk in Rome” 
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3. Clicca su Project > New Map per avviare il progetto. Poi clicca su Basemap > Imagery with labels 

 

 

 
4. Ora, aggiungi i dati illustrati nella tabella nel passaggio #1. Usa la funzione Add Data > Data 
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Nella mappa sono visualizzati 5 strati informativi (layer): 

• Roma_Circoscrizioni_WGS84 (polygon – fonte:ISTAT): suddivisioni municipali della città 

di Roma 

• Rischio_PGRAA_WGS84 (polygon – fonte: Open Data Lazio): fasce di rischio idrogeologico 

• Beni singoli (a,b) (polygon – fonte: Open Data Lazio): aree degli edifici storici 

• Punti archeologici (points – fonte: Open Data Lazio): siti d’interesse archeologico 

• Punti rurali identitari (points – fonte: Open Data Lazio): siti d’interesse architettonico 
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Verifica le caratteristiche strutturali di ogni dato (geometria, sistema di riferimento, attributi tabellari) 

per osservare le differenze informative e topologiche di ogni strato. Ciò serve per effettuare le 

operazioni di omogeneizzazione dei dati e di analisi spaziali, riportate nei passaggi successivi. 

N.B.: Le analisi spaziali sono effettuate tramite strumenti di geoprocessing. Puoi trovare i tool utili 

tramite digitando lo strumento di tuoi interesse nel riquadro posto a destra dello schermo. 

 
5. Ogni strato ha un sistema di riferimento differente. Ciò dipende dai differenti metodi di produzione di 

dati di ogni singolo produttore od ente responsabile. Riproietta perciò ogni dati caricato in WGS 1984 

Web Mercator Auxiliary Sphere tramite Geoprocessing > Project 

 

 
• Nel campo Input Dataset, inserisci il layer da riproiettare 

• Nel campo Output Dataset, definisci il percorso dove salvare il nuovo file, rinominandolo con 

il suffisso WAS (acronimo per Web Auxiliary Sphere). Ad esempio 

Roma_CircoscrizioniWAS. 

• Nel campo Output Coordinate System seleziona WGS 1984 Web Mercator Auxiliary Sphere. 

Puoi trovare il riferimento di tuoi interesse digitalizzando la dicitura della sistema di 

proiezione. 
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Infine clicca su Run e aggiungi i nuovi file al progetto. Ripetere l’operazione per ogni strato 

informativo. Per questioni di ordine si consiglia di rimuovere dal progetto i dati precedenti. 

 
6. La mappatura e le analisi sul patrimonio culturale in questo tutorial si effettuano su dati puntuali. Per 

realizzare la mappatura e l’indicizzazione spaziale dei municipi sulla base del patrimonio culturale al 

loro interno sono necessari alcuni passaggi preliminari al fine di ottenere tutti i dati di base necessari 

alla realizzazione del tutorial: 

• Trasformare il file dei Beni_singoli dal formato poligonale al formato puntuale tramite tool 

Feature to Point. Rinominare il file come “BeniSingoli_WAS_point” 

 

• Ritagliare ogni singolo layer sull’area di studio (Roma_CircoscrizioniWAS). Usa lo strumento 

CLIP, inserendo ogni layer sul campo Input Features e Roma_CircoscrizioniWAS sul campo 

Clip Features. Salva in locale i risultati rinominandoli con il suffisso _clip (esempio: 

PuntiArcheologici_clip). 

 

• Lasciare nel progetto il file delle circoscrizioni e i risultati del Clip. 
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7. Ora che tutti i dati di base sono pronti, dai uno sguardo alle tabelle degli attributi dei dati puntuali. Per 

aprire la tabella degli attributi fai click con il tasto destro del mouse sul layer nella barra dei contenuti 

> Attribute table. 

 

Puoi visualizzare così la tabella degli attributi. Noterai una differenza nella struttura e nella tipologia 

di informazioni contenute. 
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L’obiettivo è quindi quello di creare una struttura tabellare univoca di informazioni per ogni strato, in 

modo da avere e trattare dati omogenei. I campi tabellari utili al fine del tutorial sono: 

• NAME: campo testuale indicante il nome del sito, il toponimo o sigla di riferimento 

• TIPOLOGY: campo testuale indicante la tipologia del bene culturale (archeologico, 

architettonico) 
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a. Clicca sul simbolo in rosso, come visualizzato nell’immagine sottostante, poi su “Fields 

View”. 

b. Fai click su “Click here to add a new field” 

c. Compila il campo “Field name” con la parola “NAME” > scegli “Text” nel campo “Data 

Type” > inserisci 100 nel campo “Length” per definire il numero di caratteri per gli attributi tabellari 

d. Ripeti la procedura per il campo testuale TIPOLOGY 

e. Salva le modifiche tabellari cliccando su “Save” nella barra del menù superiore. 

f. Ripeti la procedura per ognuno dei tre layer puntali 

 
Ora compila i nuovi campi creati: 

Seleziona il campo NAME > Click col tasto destro del mouse > Calculate field 
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Si visualizzerà così il riquadro sottostante > Doppio click su NOME > Click su Run per eseguire il 

calcolo 

 

 
Poi cambia il Field Name con TIPOLOGY e digita 

I. “Archeological sites” per il file Punti_archeologici_clip” 

II. “Historical sites” per gli altri due layer puntuali 

 
Infine, seleziona e cancella i campi superflui. In questo modo la procedura di omogeneizzazione dei 

dati è completata. 
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8. Terminata l’omogeneizzazione dei dati, passiamo ad unire i tre strati puntuali allo scopo di creare un 

unico layer puntuale. Seleziona Geoprocessing > Digita Merge 

 

 

9. Passiamo ora ad effettuare una prima analisi spaziale, al fine di classificare i municipi di Roma sulla 

base dei siti d’interesse storico e archeologico al loro interno: 

• Digita sulla barra Geoprocessing: Summarize within 

• Apri il tool e compila i campi obbligatori richiesti 

• Nella stringa “Input polygon” seleziona il file Roma_CircoscrizioniWAS 

• Nella stringa “Input Summary Features”seleziona il file puntuale CulturalHeritage_sites 

• Nella stringa “Output Feature Class” definisci un percorso dove salvare il file di output e 
nominalo come Roma_Circoscrizioni_Summarize. Si consiglia di salvare questo file di 

output nel percorso cartelle di default del programma. 
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Nel progetto dovrebbe apparire un nouvo strato informativo sulle circoscrizioni con il 

numero di punti ricadenti in ognuno di essi, come illustrato nella figura sottostante 
 

 

 

 

10. Assegna una simbologia graduata al layer, in modo da rappresentare le circoscrizioni in base ai 

valori espressi dal numero totale dei punti all’interno di ognuna di esse. Per fare ciò, segui questi 

passaggi: 
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• Fai click con il tasto destro del mouse sul file Roma_Circosrizioni_Summarize > poi click su 

Simbology 

• Dal menù a tendina, selezionare Graduated colors 

• Da Field seleziona il campo “Count of points” e da Method scegli “Natural Breaks” come 

metodologia per la classificazione e la rappresentazione dei dati 

• Poi clicca su Color scheme > Format color scheme 

• Quando appare la schermata, scegliere Continous Color Scheme 

• Clicca sui simboli quadrati sotto la barra del colore per definire la scala cromatica di 

rappresentazione 

 

mailto:warredoc@unistrapg.it


WARREDOC.UNISTRAPG.IT 

Water Resource Research and Documentation Centre (WARREDOC) 

Università per Stranieri di Perugia - Piazza Fortebraccio 4, 06123 Perugia 

+39.075.57461 - warredoc@unistrapg.it 

 

 

 

 
 

Dovrebbe così apparire sul progetto un risultato simile a quanto illustrato nell’immagine sottostante. 

Puoi scegliere di tematizzare il layer a tuo piacimento ed applicare una trasparenza per una migliore 

visualizzazione dei dati, soprattutto se sovrapposti ad altri. Usa Appereance > Trasparence e 

definisci una percentuale di trasparenza 

 

 
Ultimati questi passaggi, sei riuscito ad ottenere un’indicizzazione dell’area di studio in base alla 

presenza di patrimonio culturale all’interno di ogni singola sezione. 

 
11. Passiamo ora ad indicizzare le circoscrizioni sulla base del patrimonio culturale esposto a fattori di 

rischio idrogeologico: 

• Vai su Geoprocessing e digita Intersect 

• Nella stringa Input Feature aggiungere CulturalHeritage_sites e rischio_PGRAA_clip 

• Nella stringa Output Feature Class, definire il percorso del file di output e nominarlo come 

Heritage_risk 

mailto:warredoc@unistrapg.it


WARREDOC.UNISTRAPG.IT 

Water Resource Research and Documentation Centre (WARREDOC) 

Università per Stranieri di Perugia - Piazza Fortebraccio 4, 06123 Perugia 

+39.075.57461 - warredoc@unistrapg.it 

 

 

 

12. Effettuare una nuova “Summarize within”, ripetendo gli stessi passaggi del punto #9: 

Attenzione: Nella stringa “Input Summary Features” seleziona il file puntuale Heritage_risk. 

Attenzione: Nomina il file di output come Roma_Circoscrizioni_SumRisk 

 
13. Assegna una simbologia per simboli proporzionali al nuovo strato informativo 

Roma_Circoscrizioni_SumRisk: 

• Richiama nuovamente la Symbology come nel punto #10 

• Dal menù a tendina Primary Symbology, seleziona Proportional Symbols 

• Nella stringa “Field” seleziona “Count of points” 

• Nella stringa “Normalization” seleziona <percentage of total> 

• Assegna un minimum size pari a 5.00 e un maximum size pari a 50.00 

• Dal template puoi eventualmente modificare colore e trasparenza del dato 

In questo modo hai portato a termine l’indicizzazione delle circoscrizioni in base al patrimonio 

soggetto a rischio. La scelta di una simbologia proporzionale consente di visualizzare e mettere a 

confronto le aree in base alla quantità e al rischio legato al patrimonio culturale. Il risultato che ne 

consegue dovrebbe apparire così: 
 

14. Associa ora le informazioni del file “CulturalHeritage_sites” con quelle del file “Heritage_risk”, in 

modo da trattare tutte le informazioni sul patrimonio in un unico layer. Questo passaggio è 

fondamentale per le successive fasi del tutorial relative alle funzioni di ArcGIS Online: 

• Vai sulla tabella dei contenuti > Click col tasto destro del mouse su “CulturalHeritage_sites” 

o click su Join and Relates > Add Join 

• Nella stringa “Input Join Field”, selezionare FID 

• Nella stringa “Output Join Field”, selezionare FID_Cultur 

• Poi clicca su Run ed esegui il join. 
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• Eseguito il join, esporta il file “CulturalHeritage_sites”. Seleziona il file dalla barra dei 

contenuti > Data > Export feature 

• Dalla stringa Output Feature Class, definisci il percorso dove salare il risultato e assegna il 

titolo di “CulturalHeritage_join” 

 

 
15. Apri la tabella di “CulturalHeritage_join. Noterai che i nomi dei campi sono stati automaticamente 

modificati. Apri la Field View, come illustrato nel passaggio #7 e segui questi passaggi: 

• Aggiungi un nuovo campo chiamato “Status”, assegna un format testuale e una lunghezza 

pari a 50. 

• Modifica l’alias dei seguenti campi: 

o CulturalHe > NAME 

o Cultural_1 > Tipology 

• Salva le modifiche apportate 

• Torna sulla tabella > Select by attribute > Add Clause 

• Seleziona l’espressione Heritage_5 is equal to “ “ (valore vuoto), poi esegui l’analisi 

• Seleziona campo Status > Calculate field > Digita “Heritage sites” 

• Clicca su Switch selection > digita “Heritage at risk” al posto di “Heritage sites” 

• Seleziona tutti i campi tranne FID, Shape, Name, Tipology e Status ed eliminali 
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16. Applica una simbologia di tipo Unique Value, scegliendo simboli e colori a tuo piacimento, 

distinguendo però i siti cultuali a rischio (Status = Heritage at risk) da quelli non a rischio (Status = 

Heritage sites). Seleziona Status come campo di riferimento per applicare la simbologia 
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La mappa realizzata dovrebbe apparire come quella nell’immagine sottostante. Essa individua 

le aree a maggiore concentrazione di patrimonio culturale in termini di numero e di esposizione 

al rischio idrogeologico. Inoltre offre una mappatura del patrimonio culturale sul territorio 

urbano di Roma. 

 

 

 

17. Prima di passare al secondo obiettivo del tutorial, incentrato alla creazione di una dashboard in 

ambiente online, effettua un ultimo passaggio utile per implementare le operazioni online. Crea 

un’intersezione fra le aree a rischio e le circoscrizioni allo scopo di ottenere uno strato informativo 

contenente informazioni sul rischio connesso alle circoscrizioni. In questo modo sarà possibile, come 

vedremo, realizzare statistiche sulle aree a rischio all’interno delle singole circoscrizioni 

• Vai su Geoprocessing > Intersect 

• Interseca gli strati come nell’immagine sottostante 
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• Nomina il file di output “Risk_intersect” ed esegui l’analisi 

• Applica una simbologia di tipo Unique Values per distinguere le 4 fasce di rischio. Usa 

qualsiasi strumento all’interno di questa funzione per tematizzare il layer a tuo piacimento 
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Obiettivo #2: Costruire una dashboard per una visualizzazione dinamica e immediata dei dati 

 
 

18. Ora che la mappa sulla versione desktop è completata, condividi il progetto su ArcGIS Online. 

• Vai su Share > Web Map 

• Compila gli Item Details 

• Analyze > Share 

Attenzione: non è possibile condividere layer con simbologia di tipo Proportional Symbol. 

In questo caso condividere il dato con simbologia Single Symbol e applicare nuovamente la 

simbologia su ArcGIS Online 

 

• Effettua l’accesso sul tuo account di ArcGIS Online e accedi ai contenuti . 
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• Apri nel Map Viewer il tuo progetto condiviso 

• Modifica la simbologia del layer “Roma Circoscrizioni SumRisk”. Usa lo strumento Change 

Style 

 

• Clicca su Styles > Vai su Choose an attribute to show e seleziona Count of points 

• Poi vai su Pick a style > Counts and Amounts (Size) >  Style Options 

• Tematizza il layer a tuo piacimento usando gli strumenti a disposizione. 

o Symbol style, per modificare il colore del layer 

o Size range, per modificare la dimensione delle features. 
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19. Segui questi passaggi per creare la tua dashboard. 

• Torna sulla lista dei contenuti > Clicca sulla Web Map > Create a Web App > Using Web App 

Builder 

 

 

• Vai su Theme > seleziona Dashboard theme > Layout 

• Delle tre opzioni disponibili, scegli la seconda 

• Vai su Widget > seleziona il primo riquadro 

• Vai su Choose Widget > Infographics > Gauge 

• Scegli il file Cultural Heritage_join 

• Attiva Filter by Extent per visualizzare dati dinamici a seconda dello zoom sulla mappa 

• Fai click sulla infografica e modifica gli attributi rischiesti in baso a ciò che vuoi visualizzare 

• Vai su Gauge Settings e imposta come valore massimo 3659 (numero pari al totale dei punti) 

e come Data Format seleziona Feature count 
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• Torna sul riquadro dei Widget > Infographics > Column 

• Attiva il Filter by extent 

• Vai su Chart settings > Display mode > Display feature counts by category 

• Poi su Category fields > Status 

• Apparirà un grafico a colonne per visualizzare il totale di patrimonio a rischio e non. 

• Aggiungi l’ultima widget > seleziona Pie 

• Assegna il titolo alla infografica “Risk surface”. Poi imposta i parametri del grafico a torta 

come nell’immagine sottostante 

 

• Tematizza il grafico a tuo piacimento andando su Display e selezionando una scala di colori a 

tua scelta 

• Salva il progetto e vai su View Application dalla lista dei contenuti sul tuo profilo di ArcGIS 

Online 

• La dashboard è pronta e dovrebbe apparire come nell’immagine sottostante. Puoi anche 

modificare la disposizione e la grandezza dei singoli riquadri spostandoli manualmente 
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Congratulazioni! 

Hai completato questo tutorial. 
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